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1 About Accessible Forms

An accessible form is one that a wide range of people can use, including those who may have disabilities 
that affect how they are able to interact with the form on the computer screen. For example, the form user 
may have a visual impairment or reduced mobility. 

Designer includes a number of features and capabilities that enhance the usability of forms for users with a 
range of disabilities, and assist form authors in creating PDF forms that are more accessible to people with 
disabilities. 

Designer provides support for tagged Adobe PDF forms. Tagged PDF forms include a complete logical 
structure plus additional information about a document’s contents that substantially increases 
accessibility.

When creating accessible forms, you need to consider whether the form is intended for interactive filling 
by end users, or whether the form is intended for viewing and printing purposes only.

See also

General considerations for designing accessible forms 
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2 Creating Accessible Forms

When you design forms for a wide audience, you should consider that some users may have disabilities 
that affect how they interact with the form. Some users may have vision impairment, reduced mobility, or 
other disabilities. To accommodate the needs of all users, you may find it worthwhile to include certain 
practical design features in your forms and to test forms using various assistive technologies.

General considerations for designing accessible forms 
Here are some tips for designing accessible forms:

● A form is not accessible if it is not easy to use. You should strive to design forms that are simple and 
usable. A simple layout of controls and fields with clear, meaningful captions and tooltips will make the 
form much easier to fill for all users.

● Designing forms that are uncluttered and logically arranged, and that provide clear and simple 
instructions will help all users to fill forms as easily as possible. The question or caption for a field 
should be on the same line as the field’s fillable area. Place captions consistently on the same side of 
the fields.

● Users work better with forms that reduce the possibility of making mistakes. Clear and concise error 
messages will help users fix any mistakes that they do make.

● Provide a flexible, customizable interface that will suit the user's needs and preferences. For example, 
some people rely on a specific color scheme to read text. Wherever possible, you should allow the user 
to customize the appearance of the form, including color schemes.

● Users should be able to fill the form completely using only the keyboard or an equivalent input device. 
Users with reduced mobility or impaired vision may have no choice but to use the keyboard, and many 
users who can use a mouse simply prefer keyboard input. By allowing various input methods, you not 
only create accessible forms, you also create forms that are better suited to the preferences of all users.

● Design your form to interact normally with other applications and system standards. For example, you 
could support standard Windows Control Panel settings for colors and use standard keyboard 
behavior.

● A well designed form will be compatible with various assistive technologies. You should familiarize 
yourself with how these technologies work and use design techniques and user interface elements that 
are compatible with a wide range of assistive technologies. 

● Color can greatly enhance a user experience with your form but only if it used properly. Colors can 
emphasize and enhance certain parts of your form, but you should not convey information by color 
alone. Large amounts of color may cause eye pain. Too much color can obscure foreground text.

● Be aware that client-side scripts can interfere with screen readers and keyboards if the script changes 
the focus of the client application. For example, the change and mouseEnter events, when used with 
drop-down lists or list boxes, have the potential to cause inappropriate actions. Client-side scripting 
should be written to avoid problems with screen readers and keyboards. 

● Radio buttons are often misinterpreted, or difficult for users with disabilities to access because web 
browsers and screen readers treat them inconsistently. Avoid using radio buttons if a list box can be 
used instead. 
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Forms for users with vision impairment 
Users with vision impairment typically use an assistive technology called a screen reader, which speaks to 
the user. A screen reader can relay information about where the cursor is displayed on the computer. The 
screen reader can also read the tooltips that you include in a form design, so it is very important to include 
tooltips in your design.

Captions and tooltip text are needed to clearly identify each field, and static text can be used to indicate 
what kind of input is required. Use tooltips to explicitly indicate which fields require input. For example, 
the caption or tooltip text can contain the words “Required input”. 

To ensure that a screen reader will work with a PDF form, you must specify spoken information for each 
object and generate a tagged PDF form. If you will be creating an HTML form from the same form design, 
screen readers can read and speak tooltips from AHTML transformations. 

Keep the following design considerations in mind to assist users with vision impairment:

● Users with vision impairment cannot use a mouse to interact with a computer. Every function must be 
available using the keyboard. For most forms, the Tab and Shift+Tab keys usually move the cursor 
forward and backward through the form. Be sure to set a logical tabbing order that includes all fields 
and buttons.

● Many forms include administrative information that provide additional general instructions to the user 
on how to complete the form. Use tooltips to ensure that all important information is read to the user 
at an appropriate time. For example, if keystrokes are required to perform a function, such as pressing 
the space bar to select a button or the down arrow to select an item from a list box, they should be 
announced to the user. 

● Include enough spoken information for users to know what input is expected and how to complete the 
field correctly, but do not overwhelm users with redundant information. 

● Add navigational buttons to the top and bottom of the form. For example, at the top of a form, you 
could include buttons such as Open Data File, Previous Page, and Next Page. At the bottom of the form 
you could include buttons such as Save Data, Email Data, Go to Top of Page, and Print. 

● Smart fields can be an effective way to make some forms easier to fill. For example, a travel request 
form may have several rows and columns of fields. The last field in each row could check if any data was 
entered in the row. If the row is empty, the Tab key could jump to the next section of the form rather 
than continuing to tab through a number of fields that will remain empty.

● Users with vision impairment or those who are color blind may have difficulty seeing the cursor. Use 
appropriate colors to display objects using a color scheme selected by the user. 

● Users with vision impairment typically use an assistive technology such as a magnification program. 
This product enlarges the cursor. Test your forms with a number of the more popular magnification 
programs to ensure that your forms are accessible.

Forms for users with reduced mobility
For users with reduced mobility and those with limited dexterity, completing a form can be very difficult. If 
a user is unable to use a mouse, every function in a form must be available using the keyboard. 

A variety of assistive technologies may be used by users with reduced mobility and those with limited 
dexterity, including special keyboards, speech-to-text software where the user speaks into a microphone 
to complete the form, or even more sophisticated technologies that can operate a computer by breath or 
eye movements.

Test your forms with a number of these assistive technologies to ensure that your forms are accessible.
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Tabbing order for accessible forms
Setting a meaningful tabbing order is very important when designing forms that are accessible to users 
with vision impairment or users with disabilities. These users typically do not use a mouse to navigate 
through a form, so they depend on the keyboard. A logical tabbing order sequence ensures that they have 
full access to all the fields on the form and that they can navigate the form in a way that is sensible and 
efficient. Screen readers and other assistive technology also make use of the tabbing order.

See also

How tabbing order works

Setting the tabbing order 

General considerations for designing accessible forms

Forms for users with vision impairment

Design for screen readers

Support for screen readers 

In order to access spoken information about a form, users with vision impairment need to use a screen 
reader. Screen readers speak information about where the cursor is located on the form. As the form 
author, you must not only specify the text for the screen reader to read, but you must also generate a 
tagged PDF form.

Designer supports certain MSAA compliant screen readers: 

● JAWS for Windows from Freedom Scientific

● Window Eyes from G.W. Micro

● Hal Screen Reader from Dolphin Computer Access

Design tips for authoring forms for screen readers

To provide an accessible form, you need to understand how screen readers work. You also need to know 
how to use the Designer Accessibility palette to specify information that the screen reader will speak for 
the objects on forms. Keep in mind these considerations related to implementing accessible forms that 
can support screen readers:

● Establish a logical tabbing order that includes all fields and buttons. Setting the tabbing order is 
important because PDF screen reader tags are ordered top-to-bottom, left-to-right. The screen reader 
will generally read through an entire page, including any boilerplate objects. When the user begins to 
tab through the form, the screen reader reads text for each field as it becomes active.

● Announce to users any special keystrokes they need to make in order to perform a function. Such 
keystrokes include actions such as pressing the spacebar to select a button, or the Down Arrow key to 
select an item from a list box. 
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● Announce the names of buttons and fields, as well as their purpose, when the user tabs into them. 
Consider these techniques:

● Announce the state of check boxes and radio buttons.

● In list box and drop-down lists, announce the default item selected in the list. Be sure that the user 
knows to use the Up Arrow and Down Arrow keys to move through the list items. Pressing the Tab 
key or the Enter or Return key will select the item in the list. Using scripting, you can set the object's 
Change event to announce which item is selected from the list. 

● Users cannot tab into protected fields. Calculation fields, such as a field that totals values entered in 
other fields, are an example of a protected field. For the screen reader to read the value of a 
protected field, you can place an empty Read Only field either on top of or next to the protected 
field to speak the value of the protected field.

For additional information, see About Creating Interactive Forms in the Designer Help.

Accessibility properties in Designer

Designer includes a number of options that support screen readers. For each object in a form, you can 
specify one of several settings for the screen reader text:

● Custom screen reader text, which you set in the Accessibility palette.

● Tooltips for objects on the finished form, which you set in the Accessibility palette.

● Captions for fields on the form. 

● Names of objects, as specified in the Name option of the Binding tab.

Only one setting is spoken for a single object. The screen reader searches for the presence of these settings 
to determine what is spoken. The default search order is Custom Text, Tooltip, Caption, and Name. When 
the screen reader finds one of these options, it speaks that text. You can override this default order using 
the Screen Reader Precedence option in the Accessibility palette.

In order for any of these options to be read by a screen reader, you must also save the form design as a 
tagged PDF form.

See also

Defining custom text for a screen reader

Defining tooltips for a screen reader

Changing the default search order for screen reader text

Turning off screen reader text for an object

Creating a PDF form with accessibility tags
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Options in the Accessibility palette 

The Designer Accessibility palette allows you to specify additional text for an object that a screen reader 
reads as it passes through the form. You can also change the default order in which the screen reader 
searches for text to read on an object-by-object basis. Through the Accessibility palette, you can turn off 
screen reader text for any object as well. You can open the Accessibility palette by selecting Window > 
Accessibility.

The following table describes the options in the Accessibility palette.

For additional information, see About the Accessibility Palette in the Designer Help.

Defining custom text for a screen reader

Use the Accessibility palette to define custom screen reader text for an object.

➤ To specify custom text for an object:

1. Select the object on the form design.

2. Click the Accessibility palette tab and, in the Custom Screen Reader Text box, type the custom text.

Option Description

Tooltip A text box where you can define a tooltip for the object on the finished 
form. A screen reader reads the text entered in this box.

Screen Reader Precedence Indicates which setting the screen reader should read first. The 
available options are: 

● Custom Text - Reads the text specified in the Custom Screen Reader 
Text box. This is the default.

● Tooltip - Reads the text specified in the Tooltip box.

● Caption - Reads the caption specified for the object.

● Name - Reads the name of the object, as specified in the Name field 
in the Binding tab of the Object palette.

● None - Disables the screen reader for the field. No text is spoken.

Custom Screen Reader Text A text box where you can define custom text for the selected object. 
The screen reader reads the text entered in this box. 
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Defining tooltips for a screen reader

Use the Accessibility palette to define a tooltip for an object. 

If there is no custom screen reader text for the object, the screen reader will, by default, read the tooltip 
text. However, if there is custom screen reader text, the screen reader, by default, reads the custom text 
and not the tooltip. You can change this default behavior using the Screen Reader Precedence option in 
the Accessibility palette.

➤ To specify a tooltip for an object:

1. Select the object on the form design.

2. Click the Accessibility palette tab and, in the Tooltip box, type the desired text.

3. If there is also custom screen reader text defined for this object, and you want the screen reader to read 
the tooltip, in the Screen Reader Precedence list, select Tooltip.

Changing the default search order for screen reader text

By default, the screen reader searches the form settings for screen reader text in the following order: 
Custom Text, Tooltip, Caption, and Name. You can override this default order using the Screen Reader 
Precedence option in the Accessibility palette.

➤ To specify a different search order for screen reader text: 

1. Select the object on the form design.

2. Click the Accessibility palette tab.

3. In the Screen Reader Precedence list, select the desired option. For example, if you want the screen 
reader to read the name instead of the caption, select Name.

Turning off screen reader text for an object 

In certain situations, you may not want the screen to read any text for an object, not even the name of the 
object. Using the Accessibility palette, you can turn off text for a screen reader on an object-by-object 
basis.

➤ To specify that the screen reader reads no text for the object: 

1. Select the object on the form design.

2. Click the Accessibility palette tab.

3. In the Screen Reader Precedence list, select None.
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Creating a PDF form with accessibility tags

In addition to specifying text for screen readers, you must also create a tagged PDF form so that the screen 
reader can read the text. You do this by generating accessibility tags when saving the form design as a PDF 
file.

In Designer, the default behavior is to create tagged PDF forms.

If Designer has been configured to not generate tagged PDF forms, use the following procedure to 
generate a tagged PDF form.

➤ To create a tagged PDF form:

1. Select File > Save.

2. In the Save as type list, select Acrobat Form Files (*.pdf ).

3. In the Save Options area, click Generate accessibility information (tags) for Acrobat.

See also

Tabbing order and tagged PDF

Techniques for testing form accessibility
To ensure that your forms are accessible to a wide variety of users, you should test them with a variety of 
assistive technologies. You can test your forms simply and inexpensively using these techniques.

● Ensure that the form can be filled using only the keyboard. Be sure to fill the entire form and test all 
fields and buttons. As you complete the form, determine whether improvements are required based on 
your answers to the following questions:

● Are there any operations that cannot be performed?

● Are any operations awkward or difficult to perform?

● Are keyboard mechanisms well-documented?

● Do all controls and menu items have underlined access keys?

● Demo versions of screen reader software can be downloaded free from the Internet. To test screen 
reader results, turn your monitor off and use only the screen reader to navigate and fill the form. 
Because you are the form author, your familiarity with the form may make it difficult to determine if the 
information read by the screen reader is sufficient and makes sense. If possible, have someone else test 
your form in this way.

● Demo versions of screen magnification software are also available for testing from the Internet.

● Speech to text software is available at a nominal cost from local computer stores. Test the form by using 
voice input only.



Adobe Designer
Creating Accessible Forms  Setting the tabbing order for a form     12

● Many users with vision impairment rely on high contrast between text and the background to read the 
form. Microsoft Windows has a high contrast color scheme that provides a display similar to what many 
users with vision impairment will be using to complete your form. To set your display to high contrast 
mode, enable the feature through Accessibility Options in the Windows Control Panel. As you complete 
the form in this mode, determine whether improvements are required based on your answers to the 
following questions:

● Do parts of the form become invisible, unrecognizable, or difficult to use?

● Do any areas continue to appear black on a white background?

● Are any elements improperly sized or truncated?

Setting the tabbing order for a form

About tabbing order 

Tabbing order is important for interactive forms and non-interactive forms alike. For interactive forms, the 
tabbing order affects the end user’s experience when filling the form. 

For both interactive and non-interactive forms, tabbing order is critical if your forms needs to be accessible 
to users with vision or mobility impairments. These users typically do not use a mouse to navigate through 
the form, so they depend on the keyboard keys and a good tabbing order sequence to ensure that they 
have full access to all the fields on the form.

Accessible forms require that you specify a tabbing order, whether the form is interactive or designed for 
print.

How tabbing order works

The default tabbing order for objects in a form is from left to right, top to bottom, starting from the 
upper-left corner. Tabbing order respects the existence of subforms, radio buttons, and content areas. For 
example, if two subforms exist side-by-side, and each subform contains a number of field objects, the 
tabbing sequence will go through the fields in the first subform before moving on to the next.

Tabbing order is also determined by the vertical position of the master page and the main subform on the 
body page. Which ever is highest receives the tab order first. That is, all objects contained within the 
content area on the master page or the main subform will be accessed first. Access then moves to the next 
highest object.

You can change the default tabbing order if you require a different sequence in your form. For example, 
you may want to change the tabbing order to move through objects in a column, from top to bottom, and 
then left to right. 

Note: Designer does not include circle, line, or rectangle objects in the tabbing order. 

See also

Setting the tabbing order
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Tabbing order and tagged PDF

Screen readers use the PDF logical structure to read a form. Logical structure is provided when you save 
the form as tagged PDF. The logical structure determines the order in which form objects are read. The 
logical structure is created in tabbing order. In a tagged PDF form, all static objects and fields are included 
in the logical structure.

If your form uses the default tabbing order, the tabbing order will be in geographic order, left-to-right, 
top-to-bottom. When you use a default tabbing order, Designer includes all static and field objects in the 
structure. A screen reader reads the form in geographic order, and reads all speak text and values for the 
static objects.

Note: If you create a large interactive PDF form with no structure, end users may experience slow 
performance in tabbing between fields. This problem is averted if you save the form without 
tagging. However, if you need your form to be accessible, you must save it as tagged PDF. To work 
around this situation, you can wrap sections of the form in unnamed subforms. This adds the 
required structure to the form.

See also

General considerations for designing accessible forms

Setting the tabbing order 

One of the final tasks you should do when creating a form is set the tabbing order. Until you have finished 
laying out the form design, the objects may move, so it is best to wait until your form design is finished 
before specifying the tabbing order. 

➤ To set a tabbing order for the fields and objects on a form:

1. Select View >Tab Order.

The body page shows the current tabbing order. In the example of the Purchase Order, we want to 
change the tabbing order so that the Ordered By information comes before the Deliver To information 
in the tabbing sequence. 
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2. Click the Finance Corporation image to designate it as the first object in the tabbing order.

The number 1 appears on the object.

3. Click the Purchase Order title to label it as the second object in the tabbing order.

The number 2 appears on the object. 

4. Click the rest of the fields in the following order: P.O. Number, P.O. Date, Ordered By, Phone Number, Fax 
Number, Contact Name, Deliver To, Phone Number, Fax Number, Contact Name.

5. Save the form design.

6. To return to normal design mode and turn off the tabbing order display, select View > Tab Order.

➤ To change the tabbing order:

1. Do one of the following:

● If the form design is not showing the tabbing order, select View >Tab Order. 

● If the tabbing order is currently displayed on the screen, select View > Tab Order to deselect it. Then 
reselect Tab Order. 

2. Click the field you want to be number 1. The tabbing order is modified so that the current field 
becomes number 1. The remaining fields are renumbered starting with the field that was previously 
number 1.

3. To continue editing the tabbing order, click the rest of the fields to establish the desired sequence.

➤ To change the tabbing order using keyboard shortcuts:

● To specify the location where you want to start editing the tabbing order, select the desired field on the 
form design and press Ctrl+click.

● To specify a new number 1 in the tabbing order, press Shift+click on the desired field.

● Hold down Ctrl+Shift on a field to drop that field from the sequence, reverting to geographic order and 
possibly splitting one sequence into two if the field was in the middle of an existing sequence.

● To save changes and leave Tab Order mode, click Enter.

● To discard changes made during the current session of the Tab Order mode, click Esc. This also exits Tab 
Order mode.

See also

About keyboard shortcuts
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3 Keyboard Shortcuts

About keyboard shortcuts
Keyboard shortcuts help you work more efficiently. Many keyboard shortcuts appear next to the 
command names in menus. 

The shortcuts for Designer are documented in this section. 

See also

Common shortcut keys 

Keys for undoing and redoing an action 

Keys for deleting text 

Keys for selecting text 

Keys for copying and moving text 

Keys for inserting paragraphs and tab characters in a text field 

Keys for applying character formats to selected text 

Keys for setting line spacing 

Keys for aligning paragraphs 

Keys for moving and copying objects 

Keys for controlling windows 

Keys for navigating a form design 

Keys for controlling menus 

Keys for Script Editor or XML Source tab 

Keys for manipulating objects 

Keys for changing the tabbing order 
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Common shortcut keys

Keys for undoing and redoing an action

Keys for deleting text

Result Action

Open the Designer Help window. F1

Activate or deactivate menu bar mode. Alt or F10

Display the shortcut menu for the selected item. Shift F10

Cancel the current task, or close an open menu or dialog box. Esc

Select. (The same as primary mouse button click). Spacebar

Move the cursor to the beginning of the text. Home

Move the cursor to top of the text. Ctrl+Home

Move the cursor to the end of the text. End

Move the cursor to end of the text. Ctrl+End

Result Action

Undo the last action. Ctrl+Z or 
Alt+Backspace

Redo the undone action. Shift+Ctrl+Z or 
Shift+Y

Result Action

Delete one character to the left. Backspace

Delete one word to the left. Ctrl+Backspace

Delete one character to the right or delete selected text without send it to the 
Clipboard.

Delete

Delete one word to the right. Ctrl+Delete

Cut the selected text and send it to the Clipboard. Ctrl+X
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Keys for selecting text
Result Action

Select or deselect one character to the right. Shift+Right Arrow

Select or deselect one character to the left Shift+Left Arrow

Select or deselect from cursor position to the end of the word. Ctrl+Shift+Right Arrow

Select or deselect from the cursor position to the beginning of the word. Ctrl+Shift+Left Arrow

Select or deselect from the cursor position to the end of the current line. Shift+End

Select or deselect from the cursor position to the beginning of the current 
line.

Shift+Home

Select or deselect from the cursor position to the same position on the next 
line. If the cursor is on the last line, the selection ends at the end of the 
current line.

Shift+Down Arrow

Select or deselect from the cursor position to the same position on the 
previous line. If the cursor is on the first line, the selection ends at the 
beginning of the current line.

Shift+Up Arrow

Select from the cursor position to the end of the paragraph. Ctrl+Shift+Down Arrow

Select from the cursor position to the beginning of the paragraph. Ctrl+Shift+Up Arrow

Select or deselect one screen to same position on next screen. Shift+Page Down

Select or deselect one screen to same position on previous screen. Shift+Page Up

Select or deselect to the beginning of the object's text (top, left text position 
of the object).

Ctrl+Shift+Home

Select or deselect to the end of the object's text (bottom, right text position 
of the object).

Ctrl+Shift+End

Selects all text in a text field or in Script Editor.

Selects all objects in a page.

Ctrl+A

Select any amount of text.  Drag over the text.

Select a word.  Double-click the word.

Select a block of text. Click at position where 
the block should begin. 
Move the mouse to the 
position where the 
block should end, hold 
down Shift, and then 
click.
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Keys for copying and moving text

Keys for inserting paragraphs and tab characters in a text field
 

Keys for applying character formats to selected text
 

Keys for setting line spacing

Result Action

Copy the selected text to the Clipboard. Ctrl+C

Paste the Clipboard content at the insertion point. Ctrl+V

Delete one character to the right or delete selected text without sending it to the 
Clipboard.

Delete

Delete one word to the right. Ctrl+Delete

Cut the selected text and put it on the Clipboard. Ctrl+X

Result Action

Add new paragraph. ENTER or 
CTRL+ENTER

Add tab character. TAB

Result Amount

Apply bold formatting (font must support Bold). Ctrl+B

Apply underline formatting. Ctrl+U

Apply italic formatting (font must support Italic). Ctrl+I

Apply 2pt baseline position and shrink font to 6pt. Ctrl+EQUAL SIGN

Apply -3pt baseline position and shrink font to 6pt. Ctrl+Shift+EQUAL SIGN

Result Action

Single-line spacing. Shift+Ctrl+1

Double-line spacing. Shift+Ctrl+2

Set 1.5-line spacing. Shift+Ctrl+5
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Keys for aligning paragraphs
 

Keys for moving and copying objects

Keys for controlling windows

Result Action

Center a paragraph. Ctrl+E

Justify a paragraph. Ctrl+J

Left align a paragraph. Ctrl+L

Right align a paragraph. Ctrl+R

Indent a paragraph from the left. Ctrl+M

Remove a paragraph indent from the left. Ctrl+Shift+M

Create a hanging indent. Ctrl+T

Reduce a hanging indent. Ctrl+Shift+T

Reset the paragraph formatting to base font. Ctrl+Q

Result Action

Copy an object Select the object and drag the mouse to the position where the object should be 
positioned. Holding down the Ctrl button, release the left mouse button.

Move an object Select the object and drag the mouse to the position where the object should be 
located. Release the left mouse button.

Result Action

Close the active document window. Ctrl+F4

Quit Designer. Alt+F4

Move to the next pane or palette. Ctrl+Tab

Move to previous pane or palette. Ctrl+Shift+Tab

Move to the next window in a group of related windows. Ctrl+F6

Move to previous window in group of related windows. Ctrl+Shift+F6

Open a new blank document. Ctrl+N

Open the Open dialog box. Ctrl+O

Open the Print dialog box. Ctrl+P

Close any open windows and files, and stop any further processing. Ctrl+Q

Toggle on/off display of rulers. Ctrl+R
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Keys for navigating a form design

Keys for controlling menus

Save the form design that currently has the input focus. Ctrl+S

Save a copy of the contents of the active form design into a new file. Shift+Ctrl+S

Toggle on/off display of grid. Ctrl+’

Toggle on/off snap to grid. Shift+Ctrl+’

Result Action

Result Action

Move to the previous page. Page Up

Move to the next page. Page Down

Move to the first page. Ctrl+Home

Move to the last page. Ctrl+End

Zoom to the actual size. Ctrl+1

Zoom fit to the page. Ctrl+0

Zoom to fit width of the page Ctrl+2

Result Action

Activate the menu bar and enter menu mode. F10 or Alt

Display the shortcut menu for the selected item. Shift+F10

Display the shortcut menu for the active window. Alt+Space

Activate the menu bar and open corresponding menu to the access key. Alt+(access keys on menu 
or selected dialog box)

Display the shortcut menu for the active child window. Alt+”-” (Hyphen)

When in Menu mode (Alt+), carries out the corresponding command. Access key

When in Menu mode (Alt+), opens menu item, moves to the one item 
below, or moves to top of menu if focus is located in the bottom of the 
menu.

Down Arrow

When in Menu mode (Alt+), moves to the one item above, or moves to 
bottom of menu if focus is located in the top of the menu.

Up Arrow

When in Menu mode (Alt+), opens the next menu to the right, or open a 
submenu.

Right Arrow

When in Menu mode (Alt+), opens the next menu to the left, or closes a 
submenu.

Left Arrow
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Keys for Script Editor or XML Source tab

Keys for manipulating objects

Result Action

Find next. F3

Find previous. Shift+F3

Open the Find dialog box. Ctrl+F

Display the Go To Line dialog box. Ctrl+G

Open the Replace dialog box. Ctrl+H

Result Action

Rename the selected object. F2

Toggle on/off display of the Font palette. Shift+F4

Toggle on/off display of the Paragraph palette. Shift+F5

Toggle on/off display of the Object palette. Shift+F7

Toggle on/off display of the Border palette. Shift+F8

Toggle on/off display of the Layout palette. Shift+F9

Reselect the deselected items. Ctrl+6

Deselect the selected items. Shift+Ctrl+A

Duplicate the specified object. Ctrl+D

Group two or more selected objects. Ctrl+G

Break up a group object that is selected in the layout. Shift+Ctrl+G

Nudge left one unit. Left Arrow

Nudge left by 10 units. Shift+Left Arrow

Nudge right one unit. Right Arrow

Nudge right by 10 units. Shift+Right Arrow

Nudge down one unit. Down Arrow

Nudge down by 10 units. Shift+Down Arrow

Nudge up one unit. Up Arrow

Nudge up by 10 units. Shift+Up Arrow

Align vertical center. Alt+Ctrl+Up Arrow

Align horizontal center. Alt+Ctrl+Right Arrow
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Keys for changing the tabbing order

Align right. Ctrl+Right Arrow

Align left. Ctrl+Left Arrow

Align top. Ctrl+Up Arrow

Align bottom. Ctrl+Down Arrow

Align vertical center. Alt+Ctrl+Up Arrow

Align horizontal center. Alt+Ctrl+Right Arrow

Align to grid. Alt+Ctrl+Left Arrow

Bring forward Ctrl+]

Bring to front. Shift+Ctrl+]

Send backward. Ctrl+[

Send to back. Shift+Ctrl+[

Result Action

Result Action

Specify the location where you want to start editing the tabbing order. Select the field and press 
Ctrl+click.

Specify a new number 1 in the tabbing order. Shift+click the field.

Save changes and leave Tab Order mode. Enter.

Discard changes made during the current session and exit Tab Order mode. Esc.

Drop the field from the tabbing order. Ctrl+Shift+click the field.
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